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	Computer Memory
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Answer: RAM

 

1.	 a. (ii)		  b. (i)	 c. (iii)	 d. (iii)
2.	 a. byte	 b. nibble	 c. RAM	 d. Hard disk
3.	 a.	The basic unit for measuring the memory of a computer is byte. 
	 b.	Pen drive is used to store data temporarily for transportation.
	 c.	Primary memory is the main memory of a computer system from which the CPU can access 

data directly.
	 d.	Cloud storage site is an online location that allows us to store data online.
	 e.	Secondary storage devices are devices used to store data permanently. e.g. Hard Disk and 

Blu-Ray Disc. 
4.	 RAM stands for Random Access  Memory. It is the primary memory of a computer system. Its 

content can be accessed by the CPU directly. It is volatile in nature.
	 ROM stands for Read Only Memory. It is non volatile storage device. Data stored in this storage 

device is not lost even if the device is shut down.
5.	 a. Cloud Storage	 b. Memory card	 c. Blu-Ray disc
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	The Computer Timeline
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Answer: 1617

 
1.	 a. (ii)		  b. (i) 	 c. (iii) 	 d. (i)
2.	 a. F 		  b. T 	 c. F
	 d. (This question was printed incorrectly in the book, please correct it in your textbook)
Q.	 Abacus is the first mathematical calculator in the world.
Ans.	F 
3.	 a.	Microprocessor 	 b. IBM 360 	 c. Pascaline 	 d. Vacuum tubes
4.	 a. John Napier created a manually-operated calculating device in 1617, called Napier's Bones. 
	 b.	Analytical Engine was the first fully programmable calculator.
	 c.	 ICs were used in the third generation of computers.
	 d.	Features of fourth generation computers are: 
		  • Reduction in the size of computer 
		  • More reliable than the earlier generation of computers with a great storage device 
		  • Extremely powerful and can process millions of instructions per second 
		  Example, Apple Macintosh.
5.	 a.	Dev’s mother is talking about the Third Generation Computers.
	 b. Fifth Generation Computers are used currently.
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Periodic Assessment–1
(Based on chapters 1 & 2)

1.	 a. Pen drive	 b. DVD	 c. Hard Disk	 d. Vaccuum Tubes 
2.	 a. 1617	 b. 1837	 c. 1822	 d. 1970	 e. 1950
3.	 a. (This question was printed incorrectly in the book, please correct it in your textbook)
Q.	 Match the following.
	 a. First Generation	 	 (i) Artificial Intelligence
	 b. Second Generation	 (ii) Integrated Chip
	 c. Third Generation	 	 (iii) Vacuum Tubes
	 d. Fourth Generation	 (iv) Transistors
	 e. Fifth Generation	 	 (v) Microprocessors
Ans.	a. (iii)		 b. (iv) 	 c. (ii) 	 d. (v) 	 e. (i) 

	Managing Files and Folders

uiz Bee
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Answer: Sub-folder

 

1.	 a. (ii)		  b. (ii)	 c. (i)	 d. (iii)
2. 	 a. Start	 b. Task view	 c. Ctrl+C	 d. File
3.	 a. Task View	 b. Recycle Bin	 c. File extension	 d. .docx
4.	 a. Live tiles are the shortcuts of applications.

	 b. A folder is a file cabinet where we can store our files and other subfolders.

	 c. Start menu is used to access all the apps of your computer from one location.

	 d. A file is a collection of data and information stored on a storage device such as a hard disk, 
pen drive, or CD/DVD. To rename a file, follow these steps:

		  1 	 Right-click the file that you want to rename. 

3.
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		  2  Select the Rename option. 

		  3  Type a new name and press the Enter key. 

	 e.	To delete a file or a folder, follow these steps: 

		  1 	 Go to the location of your file. 

		  2 	 Right-Click on the file and select the Delete option. 
5. 	 a. Pictures	 b. 3	 c. 3	 d. 1	
	 e. MS PowerPoint file
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	 Images and Objects in Word 2016
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Answer: Through

 

1.	 1. a. (i)	 b. (iii)	 c. (i)	 d. (iii)

2. 	 a. Rotate 	 b. Insert 	 c. Wrapping	 d. WordArt

3. 	 a. F		  b. T	 c. T	 d. F

4.	 a.	Wrapping text refers to how the text is positioned around objects or images. 

	 b.	Format Tab

	 c.	To apply WordArt to our document, follow the given steps: 

		  1 	 Click on the Insert tab. 
		  2 	 Click the WordArt option. 
		  3 	 Select the desired WordArt style. 
		  4 	 Type your text in the text box to apply WordArt effect.

4.
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	 d.	To add text into a shape, follow the given steps: 

		  1 	 Select the shape and right-click on it.

		  2 	 Choose the Add Text option.

		  3 	 Type the desired text.

5.	 Insert tab & Pictures command

COding Zone
COding Zone

COding Zone COding Zone{C ding z ne} []=
{} </>

Answer: 
 a. C      b. I      c. E      d. Z      e. H

Periodic Assessment–2
(Based on chapters 3 & 4)

1.	 a. Folder 	 b. Pictures Library	 c. Videos Library	 d. Word File
2.	 a. WordArt	 b. Illustrations	 c. Resizing handles	d. Format tab 
	 e. Folder	 f. Recycle Bin
3.	

4.	 a. WordArt	 b. Folder	 c. Recycle Bin	 d. Formatting
	 e. Graphics	 f. Task View

Test Sheet–1
(Based on chapters 1 to 4)

1.	 a. (iii)  	 b. (ii)	 c. (iii)	 d. (i)	 e. (iii)
	 f. (iii)		  g. (ii)
2.	 a. nibble	 b. Start	 c. Insert	 d. Wrapping
	 e. Vaccum Tubes	
3.	 a. T		  b. F	 c. F	 d. T	 e. F
4.	 a. (v) 	 	 b. (iv)	 c. (i)	 d. (ii)	 e. (iii)
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5.	 a. Yottabyte	 b. Recycle bin	 c. Insert	 d. John Napier
6.	 a. To rename a folder, follow the given steps:
		  1 	 Right-click the folder that you want to rename.
		  2 	 Select the Rename option.
		  3 	 Type a new name and press the Enter key.
	 b. Word 2016 provides an option to change the appearance of the text through the WordArt 

feature. 
		  To apply wordart to your document, follow these steps: 
		  1 	 Click on the Insert tab. 
		  2 	 Click the WordArt option. 
		  3 	 Select the desired WordArt style. 
		  4 	 Type your text in the text box to apply WordArt effect.
	 c. 	(This question was printed incorrectly in the book, please correct it in your textbook)
	 List the features of fourth generation of computers.
Ans.	Features of fourth generation of computers: 
	 • Reduction in the size of computer 
	 • More reliable than the earlier generation of computers with a great storage device 
	 • Extremely powerful and can process millions of instructions per second 
	 d. (This question was printed incorrectly in the book, please correct it in your textbook)
		  Write the steps to delete a file or folder.
Ans.		 To delete a file or a folder, follow these steps: 
		  1 	 Go to the location of your file. 
		  2 	 Right-Click on the file and select the Delete option. 

	Creating Tables in Word 2016

 

1.	 a. (ii)		  b. (i)	 c. (ii)	 d. (iii)	 e. (ii)
2.	 a. F		  b. F	 c. T	 d. F
3.	 a. (iii)		 b. (iv)	 c. (i)	 d. (ii)
4. 	 a. Insert Tab	 b. Layout Tab	 c. Two times	 d. Insert Rows below
5.	 a. Table move handle is used to move the table.
	 b. Table Styles option 

5.
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	 c. There are 4 alignments in word.
	 d. To enter data in a table, click on the cell and start typing. Press enter to keep the contents 

of the cell. 
	 e. To insert a column in a table, follow the given steps:
		  1 	 Right-click in the cell where you want to insert column.
		  2 	 Click on Insert option.
		  3 	 Click on Insert columns to the Left or Insert columns to the Right option Below option.
		  4 	 Select the desired option.
		  5 	 Click on OK button.
	 f. To apply Border and Shading styles, follow the given steps:
		  1 	 Select the table and click on the Design tab.
		  2 	 Click on down-arrow in borders.
		  3 	 Modify the Style, Color and Width options from the Borders tab.
		  4 	 Click the down arrow button of the Fill option under the Shading tab.

		  5 	 Choose the colour of your choice.
		  6 	 Click on the OK button.

6.	 Splitting Cells Merging Cells

1. �Splitting means breaking into parts. 1. �Merging means combining parts and 
making it one.

2. �It is used to divide one cell, row or column 
into two or more.

2. �It is used to combines cells,rows or columns 
to make it one.

7.	 Table
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	 Introduction to PowerPoint 2016

 

1. 	 a. (ii) 		 b. (iii) 	 c. (i) 	 d. (ii) 

6.
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2. 	 a. Slide 	 b. Quick Access Toolbar 	 c. Title 
	 d. Placeholder 
3. 	 a. Ribbon 	 b. Normal View 	 c. F5 key 	 d. Reading view 
4. 	 a.	A presentation is a sequential display of information using text, graphics, audio, video and 

animation. Presentations are widely used at offices, schools, seminars, etc. to express and 
explain ideas to a group of people.

	 b. Two components of PowerPoint: (any two)
		  (i)	� Title Bar: It is present on the top of the PowerPoint window. It displays the name of the 

presentation you are working on.
		  (ii)	� Quick Access Toolbar: It provides shortcuts to commonly used commands like Save, Undo 

and Redo.
	 c.	To save a presentation we will follow the given steps:
		  1 	 Click on the File tab.
		  2 	 Click on the Save or Save As option.
		  3 	 Click on Browse to select a location to save the file.
		  4 	 In the File name box, type the name of the presentation.
		  5 	 Click on the Save button.
	 d.	To delete a slide, follow the given steps: 
		  1 	 Right-click on the slide you want to delete from the Slide Navigation Pane.
		  2 	 Click on the Delete Slide option
	 e. PowerPoint 2016 is an application software developed by Microsoft. It allows us to create an 

attractive, eye-catching and a professional presentation. We can add many exciting effects 
like audios, videos, pictures, charts, etc. to our presentation.

5.	 Delete Silde option
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Periodic Assessment–3
(Based on chapters 5 & 6)

1.	

2.	 a. Tab		 b. Alt + End	 c. Down Arrow	 d. Alt + Page Up key

	 e. Alt + Home	 f. Alt + Page Down key	 g. Shift + Tab

	 h. Up Arrow

	More on PowerPoint 2016

uiz Bee
Page-72

Answer: Slide sorter view

 

1. 	 a. (iii) 		 b. (iii)	 c. (i) 	 d. (ii) 
2.	 a. Normal 	 b. Presenter 	 c. nine 	 d. Slide show 
3.	 a. The slide layout is the arrangement of text, images, ClipArts, charts, etc. on a particular slide.
	 b. Outline view displays the text of each slide on the left pane. 
	 c. To change the theme, follow these steps: 
		  1 	 Click on Design tab.
		  2 	 Select a theme in the Themes group.

7.
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	 d. To view a presentation in slideshow, follow these steps: 
		  1 	 Click on the Slideshow Tab 
		  2 	 Click on the From begining option in the Start Slideshow group. 
4.	 Reading View Slide Show View

Reading view is used when you want to view 
a presentation not in full screen but in a 
window with simple controls that make the 
presentation easy to review.

Slide Show view is used to run a presentation 
on full-screen mode.

5.	 Design Tab

	Blocks in Scratch

uiz Bee
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Answer: Sound block

 

1.	 a. (ii) 		 b. (i) 	 c. (ii) 	 d. (i) 
2. 	  a. T 		  b. F 	 c. F 	 d. F 
3.	 a. Logical Operators are the operators that are used to make logical decisions in a program. 
	 b. Looks blocks are used to change the appearance of the sprite. 
	 c. "Say _ for _ seconds" block displays a speech bubble for a specific amount of time. 
	 d. Control blocks have looping blocks which are used when the same blocks have to be repeated 

for a number of times.
		  Repeat block: This block repeats a set of blocks for a given number of times.
		  Forever block: This block keeps on repeating a set of blocks till the stop button is clicked. It 

is similar to repeat block and expands automatically to accommodate the blocks you snap 
inside it. 

	 e. Arithmetic operators are used to perform arithmetic operations in Scratch. Addition and 
Subtraction operators are examples of arithmetic operators. 

	 f. Greater than: Greater than operator is used to check if one operand is greater than the other. 
		  Less than: Lesser than operator is used to check if one operand is lesser than other.

8.
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		  Equals to: Equals to operator is used to see if two operands are equal.
4.	 a. This block is used to add sound to our scripts. 
	 b. This block is used to move the sprite to a specific location based on their x, y coordinates. 
	 c. This block is used to set the size of the sprite. 
	 d. This block is used to pause the script  for a given time.
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Do it yourself

	Drawing Shapes in Scratch

uiz Bee
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Answer: erase all 

 

1.	 a. (iii) 		 b. (ii) 	 c. (i) 	 d. (ii) 
2. 	 a. F		  b. T	 c. F	 d. T
3.	 a. Forever loop is used to execute a block of statement endlessly.
	 b. Pen block is used to draw shapes when the sprites move. 
	 c. Wait block is used to pause the script at any point which helps used to monitor the working 

of the script. 
	 d.	(This question was printed incorrectly in the book, please correct it in your textbook)
	  	 Write the steps to draw a circle.
	  

9.
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	 e.  

4.	 Repeat 6 times; Move 100 steps; Turn 60 degree
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	More on Internet

uiz Bee
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Answer: Homepage

 

1.	 a. (i)		  b. (ii)	 c. (iii)	 d. (ii)
2. 	 a. web pages 	 b. refresh	 c. HTML 	 d. Address bar
3. 	 a. (iii)		 b. (iv)	 c. (i)	 d. (ii)
4. 	 a. Web browser is used to surf the Internet. 
	 b. Hyperlink is a special piece of text that has the ability to jump to different part of the webpage 

or a different webpage.
	 c. Internet has enormous amount of information which is available to everyone, everytime. It 

also allows us to buy and sell things online. 

10.
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	 d. To avoid cybercrimes, do not interact with strangers and do not open e-mail from sources 
you don't know and trust.

	 e. Microsoft Edge is a web browser. Address Bar, Favourites button, Search Box and Tools button  
are components of Microsoft Edge window.

5.	 a.	He should not share his personal information like address, phone number, etc.
	 b.	She should not share her credit card details. It is very risky, but she can ask her parents to 

buy a new dress for her.
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Answer: 
a. www.google.com		  b. www.facebook.com 
c. www.twitter.com 		  d. www.wikipedia.org 

	Categories of Robots

 
1.	 a. (ii)		  b. (i)	 c. (iii)	 d. (ii)
2.	 a.	Autonomous	 b. Atlas	 c. Pre-programmed
	 d. Augmenting
3.	 (This question was printed incorrectly in the book, please correct it in your textbook)
	 a.	What are drone controllers used for?
Ans.	Drone Controllers are used for surveillance purposes and detecting landmines on the battlefield. 
	 b. WoeBot is a therapist robot designed to offer convenient care to people struggling with 

depression by mimicking human conversation and offering help and companionship to its 
users.

	 c. Heartlander Robot is used to deliver treatment to delicate locations in the body like the heart.
	 d. Augmenting robots are designed to enhance human capability or replace the abilities, 
	 a human may have lost. Prosthetic Limb or Artificial Limb is an example of augmenting robots. 
4.	 a. Atlas	 b. Augmenting robots 	 c. Woebot
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Periodic Assessment–4
(Based on chapters 7 to 11)

1.	 a. This block is used to make the sprite say something for a few seconds. 
	 b. This block is used to switch the sprite's costume to the next costume.
	 c. This block is used to add sound to the script. 
	 d. This block is used to clear all the sound effects
	 e. This block is used to hide the sprite.   
2.	 a. (iv)  	 b. (iii)	 c. (ii)	 d. (i)
3.	 a. CyberKnife	 b. Sophia	 c. Drone controller

Test Sheet–2
(Based on chapters 5 to 11)

1.	 a. (i)		  b. (iii)	 c. (i)	 d. (ii)	 e. (ii)
	 f. (i)		  g. (ii)	 h. (i)
2.	 a. placeholder	 b. 9	 c. sound	 d. pen down
	 e. address bar
3.	 a. F		  b. F	 c. F	 d. T	 e. F
4.	 a. (v) 	 	 b. (i)	 c. (ii)	 d. (iii)	 e. (iv)
5. 	 a. Pen block	 b. Microsoft Edge 	 c. Sophia
	 d. Forever loop	 e. Woebot
6.	 a. To save a presentation, follow the given steps:
		  1 	 Click on the File tab.
		  2 	 Click on the Save option.
		  3 	 Navigate to the location where you want to save the file.
		  4 	 In the File name box, type the name of the presentation.
		  5 	 Click on the Save button. 
	 b. Wait block is used to pause the execution of the block and monitor the execution and working 

of the script. 
	 c. Hyperlink is a special piece of text that has the ability to jump us to a different location on 

the same webpage or a different website. 
	 d. Augmenting robots are designed to enhance human capability or replace the abilities, a human 

may have lost. They are used in medicines. Example of Augmenting robots is Exoskeleton 
which is used to lift heavyweight objects. Paralysed man walks with the help of mind-controlled 
exoskeleton. Prosthetic Limb or Artificial Limb is also its example.




